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Раздел 1. Организационно-методический раздел 

 

1.1. Цели освоения дисциплины 

Дисциплина «Компьютерная графика» входит в перечень Элективных дисциплин 

(модули) Б1.В.ДЭ.07.01 подготовки обучающихся по направлению подготовки «09.03.03 

Прикладная информатика»,  направленность (профиль) «Прикладной искусственный 

интеллект».   
Целью дисциплины является формирование компетенций (в соответствии с ФГОС ВО и 

требованиями к результатам освоения основной профессиональной образовательной программы 

(ОПОП ВО)): 

ОПК-7. Способен разрабатывать алгоритмы и программы, пригодные для 

практического применения; 

Профессиональных: 

ОПК-7.1 – Способен разработать алгоритм работы компонентов программного продукта, 

осуществлять выбор языка для решения задачи, обосновывая выбор языка программирования и 

фреймворков с учетом специфики задач машинного обучения и анализа данных. 

ОПК-7.2 Способен разработать программный код в одной из современных сред 

программирования, в том числе с использованием сред и инструментов, ориентированных на 

разработку систем искусственного интеллекта. 

Перечисленные компетенции формируются в процессе достижения индикаторов 

компетенций: 

 

Обобщенная 

трудовая 

функция/ 

трудовая 

функция 

Код и наименование 

дескриптора 

компетенций  

Код и наименование индикатора достижения 

компетенций (из ПС) 

 
ОПК-7.1 – Способен 

разработать алгоритм 

работы компонентов 

программного продукта, 

осуществлять выбор языка 

для решения 

задачи, обосновывая выбор 

языка программирования и 

фреймворков с учетом 

специфики задач 

машинного обучения и 

анализа данных. 

ОПК-7.2 Способен 

разработать программный 

код в одной из 

современных сред 

программирования, в том 

числе с использованием 

сред и инструментов, 

ориентированных на 

разработку систем 

искусственного 

интеллекта. 

 

Знает   

ИД-1 ОПК-7.1 Принципы разработки 

алгоритмов работы компонентов программного 

продукта, методы выбора языка 

программирования и фреймворков с учетом 

специфики задач машинного обучения и 

анализа данных (без привязки к 

профессиональному стандарту) 

ИД-2 ОПК-7.2 Современные среды 

программирования, включая инструменты, 

ориентированные на разработку систем 

искусственного интеллекта, а также подходы к 

написанию программного кода (без привязки к 

профессиональному стандарту) 

 

Умеет   

ИД-3 ОПК-7.1 Разрабатывать алгоритмы 

работы компонентов программного продукта, 

осуществлять и обосновывать выбор языка 

программирования и фреймворков с учетом 

специфики задач машинного обучения и 

анализа данных (без привязки к 

профессиональному стандарту) 

ИД-4 ОПК-7.2 Разрабатывать программный код 

в одной из современных сред 

программирования, включая среды и 

инструменты, ориентированные на разработку 
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систем искусственного интеллекта (без 

привязки к профессиональному стандарту) 

 

Имеет навыки   

ИД-5 ОПК-7.1 Владение навыками 

алгоритмизации, выбора и обоснования языка 

программирования и фреймворков для решения 

задач машинного обучения и анализа данных 

(без привязки к профессиональному стандарту) 

ИД-6 ОПК-7.2 Владение навыками разработки 

программного кода в современных средах 

программирования, включая инструменты для 

создания систем искусственного интеллекта 

(без привязки к профессиональному стандарту) 

 

 

1.2. Место дисциплины в структуре ОПОП ВО 

направления подготовки «09.03.03 Прикладная информатика»,    

направленность (профиль) «Прикладной искусственный интеллект»   

 

№ 
Предшествующие дисциплины 

(дисциплины, изучаемые параллельно) 
Последующие дисциплины 

1 2 3 

1 Информационные системы и технологии Операционные системы 

2 Управление проектами  

3 Проектный практикум  

4 Мультимедиа технологии  

5 Web-программирование  

6 
Учебная практика (Технологическая 

(проектно-технологическая) практика) 
 

 

Последовательность формирования компетенций в указанных дисциплинах может быть 

изменена в зависимости от формы и срока обучения, а также преподавания с использованием 

дистанционных технологий обучения. 

 

1.3. Нормативная документация 

 

Рабочая программа учебной дисциплины составлена на основе: 

­ Федерального государственного образовательного стандарта высшего образования по 

направлению подготовки «09.03.03 Прикладная информатика»; 

­ Учебного плана направления подготовки «09.03.03 Прикладная информатика», 

направленность (профиль) «Прикладной искусственный интеллект» 2026 года набора; 

­ Образца рабочей программы учебной дисциплины (приказ № 113-О от 01.09.2021 г.). 
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Раздел 2. Тематический план 

 

Очная форма обучения (полный срок) 

 

№ Тема дисциплины 

Трудоемкость 

Всего 

Аудиторные занятия 

СРО 

Код индикатора 

и дескриптора 

достижения 

компетенций 

Л ПЗ (ЛЗ, СЗ) 

1 2 3 4 5 6 7 

1 
Введение в компьютерную 

графику 
18   18 

ИД-1 ОПК- 7.1 

ИД-2 ОПК- 7.2 

2 
Методы представления 

графической информации 
20   20 

ИД-3 ОПК- 7.1 

ИД-4 ОПК- 7.2 

3 
Цвет в компьютерной графике 

40  20 20 
ИД-5 ОПК- 7.1 

ИД-6 ОПК- 7.2 

4 
Редакторы растровой графики 

40  20 20 
ИД-3 ОПК- 7.1 

ИД-4 ОПК- 7.2 

5 

Общие понятия о технологиях 

создания веб-приложений или 

мультимедийных презентаций 

44  24 20 
ИД-5 ОПК- 7.1 

ИД-6 ОПК- 7.2 

Вид промежуточной аттестации 

(Экзамен) 
54     

Итого 216  64 98  

 

 

Очно-заочная форма обучения (полный срок) 

№ Тема дисциплины 

Трудоемкость 

Всего 

Аудиторные занятия 

СРО 

Код индикатора 

и дескриптора 

достижения 

компетенций 

Л ПЗ (ЛЗ, СЗ) 

1 2 3 4 5 6 7 

1 
Введение в компьютерную 

графику 30     30 

ИД-1 ОПК- 7.1 

ИД-2 ОПК- 7.2 

2 
Методы представления 

графической информации 30     30 

ИД-3 ОПК- 7.1 

ИД-4 ОПК- 7.2 

3 
Цвет в компьютерной графике 

40   10 30 

ИД-5 ОПК- 7.1 

ИД-6 ОПК- 7.2 

4 
Редакторы растровой графики 

40   10 30 

ИД-3 ОПК- 7.1 

ИД-4 ОПК- 7.2 

5 

Общие понятия о технологиях 

создания веб-приложений или 

мультимедийных презентаций 40   12 28 

ИД-5 ОПК- 7.1 

ИД-6 ОПК- 7.2 

Вид промежуточной аттестации 

(Экзамен) 
36     

Итого 216  32 148  
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 Раздел 3. Содержание дисциплины 

 

3.1. Содержание дисциплины 

 

Тема 1. Введение в компьютерную графику 
Понятие о компьютерной графике. Компьютерная графика как средство и способ 

управления проектами по созданию, развитию, выводу на рынок программных продуктов. 
Классификация средств компьютерной графики и анимации. Компьютерная графика для 
полиграфии (Adobe Photoshop, Adobe Illustrator, Corel Draw). Компьютерная графика для 
рисования (2D) (Painter, FreeHand). Программы для презентаций. Двумерная анимация. Пакеты 
2D-3D анимации. 

 

Тема 2. Методы представления графической информации 
Растровая графика. Векторная графика. Сравнительная характеристика векторных и 

растровых изображений. Гибридная графика. Фрактальная графика. Множество Мальдельброка. 
Создание двумерных и трехмерных изображений. Особенности редакторов растровой и векторной 
графики при разработке проектов по созданию, развитию, выводу на рынок программных 
продуктов. 

 

Тема 3. Цвет в компьютерной графике 
Основы теории цвета. Свойства цвета. Цветовые модели, их роль в разработке и управлению 

проектами по созданию, развитию, выводу на рынок программных продуктов. Палитры, 
индексированный цвет. Аддитивная цветовая модель. Формирование собственных цветовых 
оттенков в модели RGB. Субтрактивная цветовая модель. Взаимосвязь аддитивной и 
субтрактивной цветовых моделей. Цветоделение при печати. Формирование собственных 
цветовых оттенков в модели CMYK. Цветовая модель HSB и LAB. 

 

Тема 4. Редакторы растровой графики 
Adobe Photoshop: возможности, назначение при разработке и управлении проектами по 

созданию, развитию, выводу на рынок программных продуктов. Источники изображений. 
Разрешение. Рабочее окно программы Adobe Photoshop. Панель инструментов. Панели-
вспомогательные окна. Выделенная и маскированная области. Удаление фрагмента изображения. 
Выделение областей инструментами. Перемещение выделенной области и ее копии. 
Преобразование выделенной области: копирование, масштабирование, вращение, закрашивание, 
осветление, затемнение и др. Средства для уточнения предварительно созданного выделения. 
Возможность сохранения выделенной области для повторного использования. Отображение 
выделенной и маскированной области в стандартном режиме и режиме быстрой маски. Канал 
маскирования. Коллаж. Коллаж из нескольких фотографий. Слои. Перемещение выделенного 
фрагмента для создания коллажа. Спрятанный слой. Работа со слоями: удаление, перемещение, 
вращение, масштабирование отдельных слоев, изменение порядка слоев, перенос фрагмента 
изображения с одного слоя на другой. Изображение на слое как аналог объекта векторной 
графики. Выбор основного и фонового цветов. Инструменты для установки основного и фонового 
цветов. Особенности инструментов рисования. Прозрачность штриха. Раскрашивание черно-
белых фотографий. Тоновая коррекция. Тоновый диапазон изображения. Изображения и их 
гистограмма. Изменение яркости, контрастности. Уровни. Автоматическая тоновая коррекция. 
Кривые. Цветовая коррекция. Настройка баланса цветов. Цветовой оттенок/Насыщенность. 
Ретуширование изображения. 

 

Тема 5. Общие понятия о технологиях создания веб-приложений или мультимедийных 

презентаций 

Линейка программ для создания мультимедиа-приложений. Технические средства для 

разработки мультимедиа-продуктов. Создание мультимедиа-продукта с помощью Power Point. 

Создание, редактирование, преобразование продукта. Мультимедийные презентации как средство 

современного менеджмента рабочих групп.  
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3.2. Содержание практического блока дисциплины 

 

Очная форма обучения (полный срок) 

№ Тема практического (семинарского, лабораторного) занятия 

1 2 
ПЗ 1-10 Тема 3. Работа с цветовой палитрой 

ПЗ 11-14 Тема 4. Adobe Photoshop. Маски и каналы 

ПЗ 15-20 Тема 4. Adobe Photoshop. Рисование и раскрашивание 

ПЗ 21-24 Тема 5. Моделирование объектов 

ПЗ 25-28 Тема 5. Программное рисование двумерных объектов 

ПЗ 29-32 Тема 5. Программное рисование трехмерных объектов 

 

Очно-заочная форма обучения (полный срок) 

№ Тема практического (семинарского, лабораторного) занятия 

1 2 
ПЗ 1-10 Тема 3. Работа с цветовой палитрой 

ПЗ 11-14 Тема 4. Adobe Photoshop. Маски и каналы 

ПЗ 15-20 Тема 4. Adobe Photoshop. Рисование и раскрашивание 

ПЗ 21-24 Тема 5. Моделирование объектов 

ПЗ 25-28 Тема 5. Программное рисование двумерных объектов 

ПЗ 29-32 Тема 5. Программное рисование трехмерных объектов 

 

 

3.3. Образовательные технологии 

Очная форма обучения (полный срок) 

№ Тема занятия 

Вид 

учебного 

занятия 

Форма / Методы 

интерактивного 

обучения 

% учебного 

времени 

1 2 3 4 5 

1 Цвет в компьютерной графике ПЗ Проектный метод 100 

2 Редакторы растровой графики ПЗ Проектный метод 100 

3 
Общие понятия о технологиях 

создания веб-приложений или 

мультимедийных презентаций 

ПЗ Проектный метод 100 

Итого % 30 % 

 

Очно-заочная форма обучения (полный срок) 

№ Тема занятия 

Вид 

учебного 

занятия 

Форма / 

Методы 

интерактивного 

обучения 

% учебного 

времени 

1 2 3 4 5 

1 Цвет в компьютерной графике ПЗ Проектный метод 100 

2 Редакторы растровой графики ПЗ Проектный метод 100 

3 
Общие понятия о технологиях 

создания веб-приложений или 

мультимедийных презентаций 

ПЗ Проектный метод 100 

Итого % 30 % 
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Раздел 4. Организация самостоятельной работы обучающихся 

 

4.1. Организация самостоятельной работы обучающихся 

№ Тема дисциплины № вопросов 

№ 

рекомендуемой 

литературы 

1 2 3 4 

1 Введение в компьютерную графику 1-14 1-14 

2 
Методы представления графической 

информации 
27-33 

1-14 

3 Цвет в компьютерной графике 5-6 1-14 

4 Редакторы растровой графики 15-26 1-14 

5 

Общие понятия о технологиях создания веб-

приложений или мультимедийных 

презентаций 

27-38 

1-16 

 

Перечень вопросов, выносимых на самостоятельную работу обучающихся 

 

1. Теоретические основы компьютерной графики. 

2. Компьютерная графика для рисования. 

3. Сравнение растровой и векторной графики. 

4. Особенности редакторов растровой и векторной графики 

5. Модели цветов и управление цветами. 

6. Изображение в моделях: RGB, CMYK, Lab. 

7. Сохранение изображений в стандартных и собственных форматах графических редакторов. 

8. Преобразование файлов из одного формата в другой. 

9. Видео форматы. 

10. Какое свойство форматов GIF и JPEG определило их применение в сети Интернет? 

11. За счет чего происходит изменение объема файла в формате GIF и за счет чего в JPEG? 

12. Какой графический редактор позволяет оптимизировать фотографии и рисунки для 

размещения их в сети? 

13. В каком формате можно сделать анимацию из нескольких кадров для размещения в 

Интернете? 

14. Что делать, если файл с gif - анимацией получается слишком большого объема? 

15. Введение в программу Adobe Photoshop. 

16. Рабочее окно Adobe Photoshop. 

17. Средства выделения областей в Adobe Photoshop. 

18. Изучение инструментов выделения областей в Adobe Photoshop. 

19. Режимы работы с выделенными областями. 

20. Изучение двух режимов работы с выделенными областями. 

21. Хранение масок. 

22. Канал маскирования (альфа-канал). 

23. Создание компьютерного коллажа. 

24. Использование слоев для создания коллажа. 

25. Тоновая и цветовая коррекция избражения. 

26. Изучение тоновой и цветовой коррекции избражения в Adobe Photoshop. 

27. Какие бывают способы отслеживания статистики баннерной рекламы? 

28. Какие места расположения баннеров на веб-странице наиболее предпочтительны? 

29. Когда рекламные баннеры мешают работать с веб-страницой? 

30. Почему рекламные баннеры называют интерактивной рекламой? 

31. Как часто, увидев рекламный баннер, посетитель кликает на него? 

32. Как и почему ограничен объем рекламного баннера? 

33. Кто платит организатору баннерообменной системы? 

34. Web-графика. 



 9 

35. 3DstudioMax. 

36. Банеры: назначение, создание, перспективы. 

37. Какое решение нашли веб-дизайнеры для того, чтобы размещать на сайтах большие 

фотографии хорошего качества? 

38. В какой графический формат конвертируют небольшие видеоролики для размещения в сети? 

 

 

4.2. Перечень учебно-методического обеспечения самостоятельной работы обучающихся 

Самостоятельная работа обучающихся обеспечивается следующими учебно-методическими 

материалами: 

1. Указаниями в рабочей программе по дисциплине (п.4.1.) 

2. Лекционные материалы в составе учебно-методического комплекса по дисциплине 

3. Заданиями и методическими рекомендациями по организации самостоятельной работы 

обучающихся в составе учебно-методического комплекса по дисциплине. 

4. Глоссарием по дисциплине в составе учебно-методического комплекса по дисциплине. 
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Раздел 5. Фонд оценочных средств для проведения текущего контроля и промежуточной 

аттестации обучающихся 

 

Фонд оценочных средств по дисциплине представляет собой совокупность 

контролирующих материалов предназначенных для измерения уровня достижения 

обучающимися установленных результатов образовательной программы. ФОС по дисциплине 

используется при проведении оперативного контроля и промежуточной аттестации 

обучающихся. Требования к структуре и содержанию ФОС дисциплины регламентируются 

Положением о фонде оценочных материалов по программам высшего образования – программам 

бакалавриата, магистратуры. 

 

5.1. Паспорт фонда оценочных средств 

Очная форма обучения (полный срок) 

№ 
Контролируемые разделы (темы) 

дисциплины 

Оценочные средства 

Л ПЗ (ЛЗ, СЗ) СРО 

Код индикатора 

и дескриптора 

достижения 

компетенций 

1 2 3 4 5 6 

3 Цвет в компьютерной графике  ПРВ ПРВ ИД-1 ОПК- 7.1 

ИД-2 ОПК- 7.2 

4 Редакторы растровой графики  ПРВ ПРВ ИД-3 ОПК- 7.1 

ИД-4 ОПК- 7.2 

5 Общие понятия о технологиях создания 

веб-приложений или мультимедийных 

презентаций 

 ПРВ ПРВ 
ИД-5 ОПК- 7.1 

ИД-6 ОПК- 7.2 

 

Очно-заочная форма обучения (полный срок) 

№ 
Контролируемые разделы (темы) 

дисциплины 

Оценочные средства 

Л ПЗ (ЛЗ, СЗ) СРО 

Код индикатора и 

дескриптора 

достижения 

компетенций 

1 2 3 4 5 6 

3 
Цвет в компьютерной графике  ПРВ ПРВ ИД-1 ОПК- 7.1 

ИД-2 ОПК- 7.2 

4 
Редакторы растровой графики  ПРВ ПРВ ИД-3 ОПК- 7.1 

ИД-4 ОПК- 7.2 

5 
Общие понятия о технологиях создания 

веб-приложений или мультимедийных 

презентаций 

 

ПРВ ПРВ 
ИД-5 ОПК- 7.1 

ИД-6 ОПК- 7.2 

 

Условные обозначения оценочных средств (Столбцы 3, 4, 5): 

ПРВ – проверка рефератов, отчетов, рецензий, аннотаций, конспектов, графического 

материала, эссе, переводов, решений заданий, выполненных заданий в электронном виде и т.д. 
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5.2. Оценочные средства текущего контроля 

Перечень практических (семинарских) заданий  

 

Тема № 4: «Редакторы растровой графики» 

 

«Adobe Photoshop. Маски и каналы» 

Задание 1: Маска 

Открыть файл Фрукты.jpg. 

 
Методом лассо выделить очертание красной розы. 

Выбрать режим быстрой маски. 

В результате выделенный фрагмент четко будет виден на экране, а все остальное как бы 

покроется пленкой. 

На значке быстрой маски – двойной щелчок левой клавишей мыши и также на цвете пленки, 

поставить непрозрачность 40 %, можно изменить и цвет пленки. 

Увеличить масштаб изображения. 

Работать инструментами Ластик (стирает пленку) и Карандаш или Кисть (добавляет пленку). 

Таким образом мы подкорректируем выделение розы. 

Осторожно (!!!) переключаемся в режим стандартной маски, чтобы не снялось выделение и 

копируем выделенное изображение в новый файл. 

Выделение не снимать – переходить к заданию 2! 

 

Задание 2 для самостоятельной работы: 

Сохранить выделение как маску в канале 

Выделить область 

Панель каналы 

Выделение – Сохранить выделение 

Дать имя 

Показать преподавателю (!!!) 

 

Задание 3: Открыть файл Цветок.jpg 

 
Увеличить изображение (масштабом или колесиком мыши) 
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Инструмент Волшебная палочка, обратная чувствительность 100 

Щелкнуть на темной части верхнего лепестка 

Сохранить выделение в канале 

Выделение – Убрать выделение 

Сделать Ваш канал активным (двойной щелчок левой клавишей мыши на канале) 

Кистью «вычистить» все черные метки на выделении при основном цвете – белом (или сменить 

основной цвет на черный и добавить обводку) 

Загрузить границу выделения из канала 

RGB сделать активным, наш канал – невидимым (значок глаза и двойной щелчок левой клавишей 

мыши на канале) 

Выделение – Загрузить 

Копируем выделенное изображение в новый файл 

Показать преподавателю (!!!) 

 

Задание 4 для самостоятельной работы: 

 
Яблоко из файла Фрукты.jpg скопировать в канал и файл 

Цветок Ириса из файла Ирис.jpg скопировать в канал и файл 

В этом задании преподавателю показать и канал и файлы! 

  

«Adobe Photoshop. Рисование и раскрашивание» 

1. Рисование и раскрашивание 

Измените основной и фоновый цвета на красный/зеленый. Панель Цвет позволяет выбирать цвет 

из палитры. 

Инструментом Карандаш нарисуйте любое изображение на белом поле Нового документа. 

Инструмент Заливка позволит залить ЗАМКНУТУЮ область выбранным цветом переднего 

плана. Сохраните файл Ris_1.jpg 

Задание 1 для самостоятельной работы:  

Повторите п.п. 2-3 для инструмента Кисть. Сохраните файл Ris_2.jpg 

 

Задание 2: Откройте файл Собака.jpg. 

 
Основной и фоновый цвета – ч/б. Подобрав цвета, необходимо закрасить собаку, миску и 

косточку. Для этого эти три изображения поместим на новый слой, чтобы потом можно было 

отдельно работать с фоном рисунка. 

Выделите собаку, миску, косточку инструментом Волшебная палочка. Слой – Новый – Слой через 

обрезание. Смените имя слоя на Dog. Проверьте, отключив слой фона, что на выделении 

действительно все изображение. 
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Слой фона очистить полностью (или залить белым цветом). Отключите слой фона (значок глазка). 

Вычтем из существующего выделения облака, миску с косточкой, глаз и нос собаки: 

- Ctrl + щелкнуть на имени слоя Dog – выделился весь слой; 

- Alt + выделяем прямоугольной областью или эллипсом облака, миску с косточкой, нос глаз 

собаки; 

- Осталось выделение только собаки, остальное вычтено. 

Выбираем цвет с оттенком коричневого, кистью Мягкая круглая 13 пикселей со степень 

непрозрачности – 100%, закрасить изображение собаки (не полностью, см. рис.) 

Выбрать другой оттенок коричневого цвета и кистью со степенью непрозрачности 60% 

закрашиваем оставшиеся участки собаки. 

Выполнить команду Фильтр – Смазывание – Смазывание Гаусса. Подберите числовое значение 

Радиуса для получения расплывчатого изображения. 

Теперь выделим кончик носа и зальем его розовым цветом. 

Глаз, миска и косточка закрашивается аналогично. 

Сохранить файл под именем Dog1.psd 

Закрашиваем облака. Выделим их оба сразу (Shift), лучше через волшебную палочку. Если 

выделение распространяется на весь рисунок – поменяйте значение обратной чувствительности 

на меньшее. 

Командой Выделение – Модифицировать – Сжать мы добьемся, чтобы выделение не касалось 

границы облаков, т.е. при закрашивании границы не изменятся. Сжать выделение на 1 пиксел. 

Инструментом Аэрограф напылим цвет на части облака. Где-то маленькой кисточкой с давлением 

50, голубым цветом, где-то синим цветом с давлением 20, и еще серым цветом с давлением 70. 

Инструментом Палец (за инструментом Размытие) сместим и смешаем цвета соседних пикселей. 

Выбираем среднюю кисточку с мягкими краями и выполним вращательные движения для 

получения окончательной раскраски. 

Сохранить файл под именем Dog2.psd 

Добавим к иллюстрации фон, используя градиент (постепенный переход от одного цвета к 

другому по всей выделенной области). На активизированный слой BackGround наложим два 

градиента – для неба и земли. 

Инструментом Прямоугольная область выделяем область неба. Основной цвет – темно-голубой, 

фоновый – светло-голубой. Инструмент Градиент с левого верхнего угла протягиваем в нижний 

правый линию градиента. 

Инструментом Прямоугольная область (установив растушевку - 3) выделяем область земли. 

Основной цвет – зеленый, фоновый – светло-зеленый. Инструмент Градиент с левого верхнего 

угла протягиваем в нижний правый линию градиента. 

На слое BackGround дорисуем траву, кусты, деревья. 

Включив слой Dog – получим новый рисунок. 

Свести все слои и сохранить файл под именем Dog3.jpg 

2. Преобразование черно/белой фотографии в многоцветное изображение. 

Задание 3: Раскрасить черно-белую фотографию девочки. 

*Черно-белую фотографию можно только грамотно раскрасить. 

Открыть файл Моя_Девочка.jpg 
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Инструментом Лассо выделяем области лица и рук (при растушевке 2 пикселя) – добавить к 

выделению и вторую руку! 

В качестве основного выбрать телесный цвет. 

Открыть панель инструментов Заливка (режим Цвет, прозрачность 100%, чувствительность 200) 

Устанавливаем курсор внутри выделенной области, щелкаем. 

Теперь закрашиваем волосы (растушевка при выделении – 5 пикселей). 

Закрашиваем бант (растушевка при выделении – 3 пикселя, прозрачность 20) 

Выделяем платье девочки (прозрачность можно уменьшить, режим Темнее – в нем происходит 

замена только тех цветов, которые темнее вносимого, остальное остается без изменений). Цвет – 

темно-фиолетовый, например, R=102, G=9, B=123. 

Инструментом аэрограф наносим румянец на предварительно выделенную область щеки. 

Закрашиваем стол. 

Закрашиваем фон фотографии. 

Сохранить изменения в файле. 

3. Обесцветить цветную фотографию 

Задание 4: Обесцветить фотографию Девочка.jpg (или только ее часть - девочку). 

Обесцветьте фотографию выполнив действия: Изображение – установка - Обесцветить. 

 
Не забудьте, что при нажатой клавише Shift можно добавить к выделению области, а при клавише 

Alt – они вычитаются. 

Выделенная область превратилась в черно/белое изображение. 

Сохранить измененный файл. 

Задание 5 для самостоятельной работы: Раскрасить ч/б участок фотографии. 

В предыдущем файле Девочка.jpg заново раскрасить обесцвеченные участки, но другими 

цветами. 

Сохранить измененный файл. 

Задание 6 для самостоятельной работы: Раскрасить ч/б участок фотографии. 
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В предыдущем файле Девочка.jpg заново раскрасить обесцвеченные участки используя 

инструмент Color Replacement (Заменитель цвета). 

Задание 7 для самостоятельной работы: Закрасить черно/белые рисунки из файлов: 
Медведь.psd, Рыбки.psd и Мальчик.jpg. 

 
Задание 8 для самостоятельной работы:  

Отсканировать любую фотографию, обесцветить, а затем раскрасить ее. 

 

Тема № 5: «Общие понятия о технологии Flash» 

1.  «Adobe Flash. Создание объектов статичной графики» 

2. «Adobe Flash. Создание покадровой анимации» 

3. «Adobe Flash. Автоматическая анимация движения и трансформации объекта» 

4. «Adobe Flash. Автоматическая анимация. Преобразование одного объекта в другой» 

 

Тема № 6: «Создание Flash-анимации средствами Action Script» 

 «Свободное движение графического объекта» 

Порядок выполнения работы: 

1. Откройте приложение Flash. 

2. Ознакомьтесь с графическим интерфейсом приложения, изучите положения и свойства 

панелей Tools, Project, Properties и Color Mixer. 

3. Для сброса положения панелей в исходное состояние по умолчанию используйте 

команду меню Window > Panel Sets > Default Layout. 

4. Командой меню File > New... > Flash Project создайте новый проект, назовите его "lab01" 

и сохраните в папке с названием "lab01". Тип файла, в котором сохраняется проект – FLP, полное 

название файла – "lab01.flp". 

5. Обратите внимание на панель проектов Project (включается командой меню Window > 

Project, находится в правой части окна приложения). Кнопка внизу панели с названием Test 

Project необходима для компиляции проекта. При её нажатии открывается окно для отображения 

файла типа SWF. 

6. Для того, чтобы максимизировать панель Project, необходимо в контекстном меню 

заголовка панели выбрать команду Maximize Panel. 

7. Для того, чтобы добавить папку или файл к проекту, используйте соответственно две 

кнопки Add Folder to Project и Add File(s) to Project, расположенные внизу панели. Третья кнопка 

Remove from Project работает в том случае, если выбран элемент для удаления из состава проекта. 

8. Командой меню File > New... > Flash Document создайте новый документ. Командой File 

> Save As... сохраните его под названием "lab01" в папке "lab01". Тип сохраняемого файла – FLA, 

полное название файла – "lab01.fla". 

9. Добавьте файл "lab01.fla" к проекту "lab01". 

10. На панели свойств Properties (включается командой Window > Properties, находится в 

нижней части окна приложения) в документе "lab01.fla" проверьте или установите следующие 

свойства: Size – 550 x 400 pixels; Background – #ffffff; Frame rate – 30 fps; Publish > Settings... > 

Current Profile – Default. На вкладке Flash проверьте или установите: Version – Player 7; Load 
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order – Bottom up; ActionScript version – ActionScript 2.0. 

11. На панели инструментов Tools (включается командой меню Window > Tools, находится в 

левой части окна приложения) найдите инструмент для рисования прямоугольников Rectangle 

Tool и изобразите в рабочей части окна прямоугольник, предварительно в разделе Colors (нижняя 

часть панели) установив следующие значения: Stroke Color – No Color (красное перечёркивание); 

Fill Color – #0099ff. 

12. Выделите инструментом Selection Tool закрашенный прямоугольник. Включите панель 

цветового микшера Color Mixer (команда Window > Color Mixer, в правой части окна приложения) 

и установите следующие параметры градиентного закрашивания прямоугольника: тип 

закрашивания – Linear, Color Proxy первый цвет – #000000, второй цвет – #0099ff. 

13. Выделите инструментом Selection Tool закрашенный прямоугольник. Выберите 

инструмент Free Transform Tool и поверните направление закрашивания за правый верхний угол 

на 90° против часовой стрелки. Уменьшите размеры закрашивания до размеров прямоугольника. 

14. Выделите прямоугольник и установите для него следующие свойства (на панели 

Properties): W – 550, H – 400, X – 0, Y – 0. 

15. Выделите прямоугольник и командой Modify > Convert to Symbol переведите его в объект 

типа Graphic, используя следующие параметры: Name -"Background"; Behavior – Graphic; 

Registration – верхняя левая ячейка (точка); Linkage – Export for ActionScript; Identifier – 

"Background". 

 
Параметры перевода графического элемента в объект 

 

16. Включите панель библиотеки Library (командой Window > Library, нижняя правая часть 

окна). Обратите внимание на объект "Background" типа Graphic, который только что был создан и 

теперь присутствует в библиотеке. 

17. Инструментом Oval Tool изобразите окружность за пределами сцены, переведите его 

аналогичным образом в объект типа MovieClip с названием "Ball" и установите следующие 

свойства: W – 50, H – 50, X – 0, Y – 0. 

18. Проверьте работу проекта (Test Project) и удалите все объекты со сцены. 

19. Для того, чтобы создать экземпляры существующих объектов из 

библиотеки на сцене, в первом кадре на панели действий Actions (Window > Development 
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Panels > Actions) (рис. 2) напишите следующий сценарий: 

_root.attachMovie("Background", "background", 0); 

_root.attachMovie("Ball", "ball", 1); 

20. Проверьте работу проекта "lab01". 

21. Командой File > New... > ActionScript File создайте файл класса, имеющий тип AS и 

сохраните его под названием "Main" в той же папке где были сохранены все предыдущие файлы, 

полное название файла будет "Main.as". Добавьте этот файл, как и все остальные, к проекту 

"lab01". 

22. В классе Main необходимо описание функции-конструктора, которая будет вызвана при 

создании экземпляра класса во внешней среде Flash IDE. В тело конструктора необходимо 

перенести строки сценария из первого кадра сцены. (т.е удалить все что там было).Также 

необходимо ввести управляющую переменную target типа MovieClip, через которую будет указан 

вызывающий объект: 

class Main { 

var target:MovieClip; 

// Constants: 

public static var CLASS_REF = Main; 

public function Main(target) { 

target.attachMovie("Background", "background", 0); 

target.attachMovie("Ball", "ball", 1); 

} 

} 

23. Для того, чтобы создать экземпляр класса Main на сцене, достаточно в первом кадре 

написать одну строку создания переменной main типа Main и передать название вызывающего 

объекта (this, то есть самого себя). 

var main:Main = new Main(this); 

24. Документ "lab01.fla" можно закрыть и больше к нему не возвращаться. 

25. Если в проекте присутствует более одного файла, то в диалоговом окне Default Document 

Required необходимо указать файл запуска приложения по умолчанию. В данном случае этим 

файлом будет являться "lab01.fla". 

26. Для дальнейшей работы необходимо создать внутренний метод init() в классе Main, в 

который нужно перенести следующие строки: 

public function Main(target) { 

this.target = target; 

init(); 

} 

private function init() { 

this.target.attachMovie("Background", "background", 0); 

this.target.attachMovie("Ball", "ball", 1); 

} 

27. Создайте новый класс Motion, содержащий методы для движения 

графических объектов. Этот класс будет являться наследником класса 

MovieClip, что обозначается в заголовке. Для класса необходимо задать несколько новых 

глобальных переменных с указанием типа: 

class Motion extends MovieClip { 

// Constants: 

public static var CLASS_REF = Motion; 

var object:Object; 

var target:MovieClip; 

var vx, vy:Number; 

public function Motion(target, vx, vy) { 

this.target = target; 

this.target.object = this; 

this.vx = vx; 
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this.vy = vy; 

} 

private function stepMotion() { 

this._x += this.object.vx; 

this._y += this.object.vy; 

} 

public function startMotion() { 

this.target.onEnterFrame = this.stepMotion; 

} 

} 

28. Для того, чтобы воспользоваться методами класса Motion, необходимо передать ему 

подвижный объект в виде переменной: 

var ball:MovieClip = this.target.attachMovie("Ball", "ball", 1); 

т.е добавить в тело процедуры init : 

private function init() 

{ 

this.target.attachMovie("Background","background",0); 

this.target.attachMovie("Ball","ball",1); 

var ball:MovieClip = this.target.attachMovie("Ball","ball",1); 

} 

29. Для того, чтобы передать объект типа MovieClip классу Motion для управления, 

необходимо создать переменную, а затем вызвать для неё метод: 

var motion:Motion = new Motion(ball, 4, 4); 

motion.startMotion(); 

т.е добавить в тело процедуры init : 

private function init() 

{ 

this.target.attachMovie("Background","background",0); 

this.target.attachMovie("Ball","ball",1); 

var ball:MovieClip = this.target.attachMovie("Ball","ball",1); 

var motion:Motion = new Motion(ball,4,4); 

motion.startMotion(); 

} 

30. Самостоятельно перепишите код одного из классов таким образом, чтобы объект ball 

передвигался точно по диагонали сцены при любых её размерах. 

 «Ограниченное движение графического объекта» 

Порядок выполнения работы: 

1. Создайте новую папку, новый проект типа Flash Project и новый документ типа Flash 

Document с одинаковыми названиями "lab02". 

2. В документе "lab02.fla" создайте два объекта "Background" и "Ball" типа MovieClip с 

параметрами из предыдущей работы, перенесите их в библиотеку документа. На первом кадре 

создайте экземпляр класса Main. 

3. Скопируйте классы Main и Motion из предыдущей практической работы. 

4. Создайте новый класс Collision, являющийся наследником класса Motion: 

class Collision extends Motion {...} 

получаем: 

class Collision extends Motion {// Constants: 

public static var CLASS_REF = Collision; 

public function Collision() {// constructor code} 

} 

5. Аргументами для конструктора класса Collision будут являться те же значения, что и для 

класса Motion, поэтому их необходимо передать с помощью оператора вызова суперконструктора 

super(): 

public function Collision(target, vx, vy) { 
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super(target, vx, vy); 

this.target.stepMotion = this.stepMotion; 

} 

т.е. получаем: 

class Collision extends Motion{// Constants: 

public static var CLASS_REF = Collision; 

public function Collision(target, vx, vy) 

{ 

super(target,vx,vy); 

this.target.stepMotion = this.stepMotion; 

} 

} 

6. Единственным методом в классе Collision будет метод startMotion(), который полностью 

повторяет аналогичный метод класса Motion. 

получаем: 

class Collision extends Motion{// Constants: 

public static var CLASS_REF = Collision; 

public function Collision(target, vx, vy) 

{ 

super(target,vx,vy); 

this.target.stepMotion = this.stepMotion; 

} 

public function startMotion() 

{ 

this.target.onEnterFrame = this.stepMotion; 

} 

} 

7. Для того, чтобы расширить список вызовов методом onEnterFrame, необходимо 

использовать анонимную функцию function(), например: 

this.target.onEnterFrame = function() {...}; 

получаем: 

class Collision extends Motion{// Constants: 

public static var CLASS_REF = Collision; 

public function Collision(target, vx, vy) 

{ 

super(target,vx,vy); 

this.target.stepMotion = this.stepMotion; 

} 

public function startMotion() 

{ 

this.target.onEnterFrame = function() { this.stepMotion();}; 

} 

} 

8. Для того, чтобы сравнить взаимное расположение двух графических объектов, 

необходимо присоединить один объект к другому, например: 

var background:MovieClip = this.target.attachMovie("Background", "background", 0); 

var ball:MovieClip = background.attachMovie("Ball", "ball", 0); 

этими строками заменить строки в main.as : 

this.target.attachMovie("Background","background",0); 

this.target.attachMovie("Ball","ball",1); 

9. В конструкторе класса Motion создать переменные bx и by типа Number и присвоить им 

значения границ неподвижного объекта background: 

this.bx = target._parent._width; 

this.by = target._parent._height; получаем: 
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public function Motion(target, vx, vy) 

{this.target = target; 

this.target.object = this; 

this.vy = vy; 

this.vx = vx; 

this.bx = target._parent._width; 

this.by = target._parent._height;} 

10. Для того, чтобы проверить, будет ли объект ball своей нижней точкой соприкасаться с 

границей background, в анонимной функции обработки метода onEnterFrame необходимо написать 

следующее условие: 

if (this._y> this.object.by-this._height) { 

this.object.vy *= -1; 

} 

11. Самостоятельно напишите ещё три условия для проверки столкновения с остальными 

границами объекта background, а также вызов метода метод startMotion() класса Collision. 

 
Ограниченное движение графического объекта 

 

условия: 

this.target.onEnterFrame = function() 

{ 

this.stepMotion(); 

if (this._y > this.object.by - this._height) 

{ 

this.object.vy *= -1; 

} 

if (this._x > this.object.bx - this._width) 

{ 

this.object.vx *= -1; 

} 

if (this._y < 0) 

{ 

this.object.vy *= -1; 

} 

if (this._x < 0) 

{ 

this.object.vx *= -1; 

}; 

} 

вызов в main.as в функции init 

private function init() 
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{ 

var background:MovieClip = this.target.attachMovie("Background", "background", 0); 

var ball:MovieClip = background.attachMovie("Ball", "ball", 0); 

var collision: Collision = new Collision(ball, 4, 4); 

collision.startMotion(); 

} 

 

5.3. Тематика письменных работ обучающихся 

Тематика докладов по дисциплине 

1. Основные этапы развития компьютерной графики. 

2. Область применения и тенденции развития графических систем. 

3. Понятие графического ядра, графического приложения. 

4. Формы представления графических данных в компьютере. 

5. Основные параметры изображений (пиксели, точки, разрешение, линиатура). Понятие 

глубины изображений. 

6. Способы хранения графической информации. 

7. Понятие растровой и векторной графики. Статические и анимированные графические 

объекты. 

8. Основы теории цвета. Цветовые модели. 

9. Модель цветов RGB. Область ее применения. 

10. Модель цветов CMYK. Область ее применения. 

11. Модель цветов HSB. Область ее применения. 

12. Обзор и классификация технических средств компьютерной графики. 

13. Графические мониторы. 

14. Графические адаптеры. 

15. Принтеры и плоттеры. 

16. Web-камеры. Графические устройства захвата и монтажа видеоизображений. 

17. Основные типы преобразований графических объектов. 

18. Классификация графических форматов. 

19. Сжатие графических данных. Преобразование форматов изображений. 

20. Основные этапы обработки графических изображений. 

21. Алгоритмы визуализации: отсечения, развертки, удаления линий и поверхностей, закраски. 

22. Понятие "растровое изображение": особенности, параметры и форматы растровых 

изображений. 

23. Основные возможности и область применения приложения Adobe Photoshop. 

24. Понятие «векторное изображение». Графические примитивы. Выделение и преобразование 

объектов. Основные приемы работы с растровыми объектами (управление масштабом, режимы 

просмотра, копирование, группировка). 

25. Понятие двумерных (2D) и трехмерных (3D) моделей графических объектов. Проблемы 

геометрического моделирования. 

26. Виды геометрических моделей и их свойства. Трансформация моделей. Основные 

атрибуты графической модели. 

27. Обзор компьютерных приложений 2D и 3D моделирования. 

28. Обзор программного обеспечения векторной и растровой графики. 

29. Открытые графические системы. 

 

 

5.4. Перечень вопросов промежуточной аттестации по дисциплине 

Вопросы к экзамену 

1. Объекты типа MovieClip и Graphic.  

2. Базовые действия ActionScript. Создание интерактивных элементов управления. 

3. Создание интерактивного резюме с использованием базовых действий и навигационной 

панели. 

4. Язык ActionScript. Управление вводом-выводом данных. 
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5. Использование ActionScript. 

6. Написание сценариев ActionScript. 

7. Повышение интерактивности фильмов с помощью ActionScript. 

8. Отладка сценариев ActionScript. 

9. Язык ActionScript. Классы. Наследование методов классов. 

10. Язык ActionScript. Функции.  

11. Язык ActionScript. Переменные. Определение переменной массива. 

12. Язык ActionScript. Свойства. Управление характеристиками объекта  

13. Основные термины и определения компьютерной графики. 

14. Область применения и тенденции развития графических систем.  

15. Формы графических файлов.  

16. Способы хранения графической информации.  

17. Понятие растровой и векторной графики. Статические и анимированные графические 

объекты. 

18. Фрактальная графика.  

19. Основы теории цвета. Цветовые модели.  

20. Модель цветов RGB. Область ее применения. 

21. Модель цветов CMYK. Область ее применения. 

22. Основные возможности и область применения приложения 3D StudioMax. 

23. Понятия Web-графики и Web-дизайна. Направления и стили в Web-графике. Типовые решения 

в дизайне Web-страниц. 

24. Виды графических Интернет-ресурсов и области их применения. Web-редакторы. 

25. Основные возможности и область применения приложения Adobe Photoshop. 

26. Векторная графика. Гибридная графика. Графические примитивы. Выделение и 

преобразование объектов. Основные приемы работы с растровыми объектами (управление 

масштабом, режимы просмотра, копирование, группировка).  

27. Применение разных видов графики. 
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Раздел 6. Оценочные средства промежуточной аттестации (с ключами) 

 

1. Для хранения 256-цветного изображения на один пиксель требуется 

а) 2 байта 

б) 4 бита 

в) 256 битов 

г) 256 байт 

д) 1 байт 

Правильный ответ: д) 

 

2. В процессе преобразования растрового графического файла количество цветов уменьшилось с 

65 536 до 256. Укажите, во сколько уменьшится объем файла 

а) 4 раза 

б) 2 раза 

в) 8 раз 

г 16 раз 

д) 256 раз 

Правильный ответ: б) 

 

3. Виды компьютерной графики 

а) растровая 

б) фрактальная 

в) векторная 

г) плоская 

д) кубическая 

Правильный ответ: а), б), в) 

 

4. Базовые цвета RGB модели   

а) черный 

б) белый 

в) красный 

г) зеленый 

д) синий 

Правильный ответ: в), г), д) 

 

5. Графические редакторы, работающие с растровой графикой 

а) Adobe Photoshop  

б) Corel Draw 

в) Paint  

г) PowerPoint 

д) Word 

Правильный ответ: а), в) 

 

6. Графика с представлением изображения в виде совокупностей точек называется 

_________________ 

Правильный ответ: растровой 

 

7. ____________  – это сетка из горизонтальных и вертикальных столбцов, которую на экране 

образуют пиксели 
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Правильный ответ: растр 

 

8. ________________ графика представляет изображения в виде последовательности точек со 

своими координатами, соединенных между собой кривыми, которые описываются 

математическими уравнениями 

Правильный ответ: векторная 

 

Раздел 7. Перечень учебной литературы, необходимой для освоения дисциплины 

 

7.1. Основная литература 

1. Боев, В. Д. Компьютерное моделирование : учебное пособие / В. Д. Боев, Р. П. 

Сыпченко. — 3-е изд. — Москва : Интернет-Университет Информационных Технологий 

(ИНТУИТ), Ай Пи Ар Медиа, 2021. — 517 c. — ISBN 978-5-4497-0888-5. — Текст : 

электронный // Цифровой образовательный ресурс IPR SMART : [сайт]. — URL: 

https://www.iprbookshop.ru/102015.html  

2. Компьютерная графика и геометрическое моделирование : учебно-методическое 

пособие / Е. В. Конопацкий, А. И. Бумага, О. С. Воронова, А. А. Крысько. — Макеевка : 

Донбасская национальная академия строительства и архитектуры, ЭБС АСВ, 2021. — 241 

c. — Текст : электронный // Цифровой образовательный ресурс IPR SMART : [сайт]. — 

URL: https://www.iprbookshop.ru/120025.html 

3. Куликов, А. И. Алгоритмические основы современной компьютерной графики : 

учебное пособие / А. И. Куликов, Т. Э. Овчинникова. — 3-е изд. — Москва : Интернет-

Университет Информационных Технологий (ИНТУИТ), Ай Пи Ар Медиа, 2021. — 230 c. 

— ISBN 978-5-4497-0859-5. — Текст : электронный // Цифровой образовательный ресурс 

IPR SMART : [сайт]. — URL: https://www.iprbookshop.ru/101990.html 

4. Лисяк, В. В. Математические основы компьютерной графики: преобразования, 

проекции, поверхности : учебное пособие / В. В. Лисяк. — Ростов-на-Дону, Таганрог : 

Издательство Южного федерального университета, 2020. — 103 c. — ISBN 978-5-9275-

3490-6. — Текст : электронный // Цифровой образовательный ресурс IPR SMART : [сайт]. 

— URL: https://www.iprbookshop.ru/107952.html 

5. Смирнова, А. М. Компьютерная графика и дизайн художественных изделий. 

Основы визуализации : учебное пособие / А. М. Смирнова. — Санкт-Петербург : Санкт-

Петербургский государственный университет промышленных технологий и дизайна, 2020. 

— 145 c. — ISBN 978-5-7937-1921-6. — Текст : электронный // Цифровой образовательный 

ресурс IPR SMART : [сайт]. — URL: https://www.iprbookshop.ru/118385.html 

6. Черных, Т. Е. Компьютерные графические системы визуализации : практикум / Т. Е. 

Черных, А. В. Тикунов. — Воронеж : Воронежский государственный технический 

университет, ЭБС АСВ, 2021. — 61 c. — ISBN 978-5-7731-0922-8. — Текст : электронный 

// Цифровой образовательный ресурс IPR SMART : [сайт]. — URL: 

https://www.iprbookshop.ru/111499.html 

 

7.2. Дополнительная литература 

7. Артюшенко, В. В. Компьютерные сети и телекоммуникации : учебно-методическое 

пособие / В. В. Артюшенко, А. В. Никулин. — Новосибирск : Новосибирский 

государственный технический университет, 2020. — 72 c. — ISBN 978-5-7782-4104-6. — 

Текст : электронный // Цифровой образовательный ресурс IPR SMART : [сайт]. — URL: 

https://www.iprbookshop.ru/99345.html  

8. Медведева, А. А. Компьютерная графика : практикум / А. А. Медведева. — Санкт-

Петербург : Санкт-Петербургский государственный университет промышленных 

технологий и дизайна, 2020. — 123 c. — ISBN 978-5-7937-1893-6. — Текст : электронный // 

Цифровой образовательный ресурс IPR SMART : [сайт]. — URL: 

https://www.iprbookshop.ru/118386.html 

9. Лабораторные работы по программе AutoCAD 2018 : учебно-методическое пособие 

https://www.iprbookshop.ru/102015.html
https://www.iprbookshop.ru/118386.html
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/ Т. П. Бондарева, Л. И. Головачёва, В. И. Серёгин [и др.]. — Москва : Московский 

государственный технический университет имени Н.Э. Баумана, 2020. — 48 c. — ISBN 

978-5-7038-5492-1. — Текст : электронный // Цифровой образовательный ресурс IPR 

SMART : [сайт]. — URL: https://www.iprbookshop.ru/115338.html 

 

7.3. Перечень ресурсов информационно-телекоммуникационной сети «Интернет» 

10. Журнал Computer World. URL: http://www.osp.ru/cw/index.html 

11. Журнал Компьютера. URL: http://www.computerra.ru/features/ 

12. Интернет-университет информационных технологий INTUIT.ru. – URL: 

http://www.intuit.ru 

13. Сайт фирмы Adobe. URL: www.adobe.com 

14. Электронный журнал о звуке. URL: http://websound.ru/index.html. 

15.  http://www.consultant.ru/— Консультатнт Плюс 

16.  http://www.garant.ru/— Гарант 

17.  ПО для организации конференций 

 

http://websound.ru/index.html
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Раздел 8. Материально-техническая база и информационные технологии 

 

Материально-техническая база, необходимая для осуществления образовательного 

процесса по дисциплине: 

 

Материально-техническое обеспечение дисциплины «Компьютерная графика» включает в 

себя учебные аудитории для проведения занятий, групповых и индивидуальных консультаций, 

текущего контроля и промежуточной аттестации, самостоятельной работы обучающихся. 

Учебные аудитории укомплектованы специализированной мебелью и техническими 

средствами обучения. Помещения для самостоятельной работы обучающихся оснащены 

компьютерной техникой с возможностью подключения к сети Интернет. 

Дисциплина может реализовываться с применением дистанционных технологий обучения. 

Специфика реализации дисциплины с применением дистанционных технологий обучения 

устанавливается дополнением к рабочей программе. В части не противоречащей специфике, 

изложенной в дополнении к программе, применяется настоящая рабочая программа. 

Материально-техническая база, необходимая для осуществления образовательного процесса 

по дисциплине с применением дистанционных образовательных технологий включает в себя: 

Компьютерная техника, расположенная в учебном корпусе Института (ул.Качинцев, 63, 

кабинет Центра дистанционного обучения): 

1. Intel i 3 3.4Ghz\ОЗУ 4Gb\500GB\RadeonHD5450 

2. Intel PENTIUM 2.9GHz\ОЗУ 4GB\500GB 

3 личные электронные устройства (компьютеры, ноутбуки, планшеты и иное), а также 

средства связи преподавателей и студентов. 

Информационные технологии, необходимые для осуществления образовательного процесса 

по дисциплине с применением дистанционных образовательных технологий включают в себя: 

- система дистанционного обучения (СДО) (Learning Management System) (LMS) Moodle 

(Modular Object-Oriented Dynamic Learning Environment); 

- электронная почта; 

- система компьютерного тестирования; 

- Цифровой образовательный ресурс IPR SMART; 

- система интернет-связи skype; 

- телефонная связь; 

- ПО для организации конференций 

Обучение обучающихся инвалидов и обучающихся с ограниченными возможностями 

здоровья осуществляется посредством применения специальных технических средств в 

зависимости от вида нозологии. 

При проведении учебных занятий по дисциплине используются мультимедийные 

комплексы, электронные учебники и учебные пособия, адаптированные к ограничениям здоровья 

обучающихся. 

Лекционные аудитории оборудованы мультимедийными кафедрами, подключенными к 

звуковым колонкам, позволяющими усилить звук для категории слабослышащих обучающихся, а 

также проекционными экранами, которые увеличивают изображение в несколько раз и позволяют 

воспринимать учебную информацию обучающимся с нарушениями зрения. 

При обучении лиц с нарушениями слуха используется усилитель слуха для слабослышащих 

людей CyberEar модель HAP-40, помогающий обучаемым лучше воспринимать учебную 

информацию. 

Обучающиеся с ограниченными возможностями здоровья, обеспечены печатными и 

электронными образовательными ресурсами (программы, учебники, учебные пособия, материалы 

для самостоятельной работы и т.д.) в формах, адаптированных к ограничениям их здоровья и 

восприятия информации: 

для лиц с нарушениями зрения: 

- в форме электронного документа; 

- в форме аудиофайла; 

для лиц с нарушениями слуха: 
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- в печатной форме; 

- в форме электронного документа; 

для лиц с нарушениями опорно-двигательного аппарата: 

- в печатной форме; 

- в форме электронного документа; 

- в форме аудиофайла. 
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Раздел 9. Методические указания для обучающихся по освоению дисциплины 

 

Одной из целей подготовки обучающихся по дисциплине является формирование и развитие 

личностных качеств будущих программистов. При этом также решается задача воспитания 

высокой культуры творческого обращения с наукой. 

Широта кругозора специалиста любого профиля является насущной потребностью нашего 

общества. Для создания условий формирования технического кругозора необходима интеграция 

знаний, полученных на разных уровнях образования. Будущее поколение должно бережно 

хранить и приумножать достижения человеческой культуры. Важно, чтобы оно не оставалось 

равнодушным, а могло изменять себя и влиять на окружающий мир. 

Аудиторные занятия должны не только давать систематизированные основы научных 

знаний по соответствующей теме, раскрывать состояния и перспективы развития 

рассматриваемых вопросов, сконцентрировать внимание обучающихся на наиболее сложных 

узловых вопросах, но и стимулировать их активную познавательную деятельность, формировать 

инженерное и творческое мышление. При изучении дисциплины обучающийся должен получить 

представление о роли изучаемой дисциплины в современном мире, в мировой истории и 

культуре.  

Для успешного усвоения материала обучающийся должен просмотреть учебную литературу 

по теме с тем, чтобы иметь представление о проблемах и задачах, которые будут решатся в 

дальнейшем. Иногда для этого бывает достаточно ознакомиться с рабочей программой 

дисциплины или учебным руководством. 

Тематическим планом изучения дисциплины предусмотрены практические занятия. 

Подготовка к практическому занятию предполагает два этапа работы обучающихся. 

Первый этап – усвоение теоретического материала. На первом этапе обучающийся должен 

отработать и усвоить учебно-программный вузовский материал, используя методические 

рекомендации и рекомендуемую литературу. 

Второй этап предполагает выполнение практического задания. Конкретно такое задание 

дается обучающемуся преподавателем в конце занятия, предшествующего практическому.  

Задания должны быть выполнены графически с применением программного обеспечения. 

Кроме того, по теоретическим вопросам, выносимым на СРО, обучающийся должен подготовить 

рабочие планы своих ответов на них. 

Рекомендуется чаще обращаться за консультациями и оказанием необходимой помощи к 

преподавателям кафедры. 
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Учебно-методическое издание 

 

 

Рабочая программа учебной дисциплины 

 

 

 

 

 

Компьютерная графика 
(Наименование дисциплины в соответствии с учебным планом)  

Гвоздкова Ирина Николаевна 
(Фамилия, Имя, Отчество составителя) 

 

 

 


